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Blocos O Controlador Lógico Programável oferece vários tipos de blocos nos quais o programa 
do usuário e seus dados podem ser armazenados. Dependendo das necessidades do 
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do usuário e seus dados podem ser armazenados. Dependendo das necessidades do 
processo este programa pode estar estruturado em diferentes blocos.

Bloco de Os Blocos de Organização (OBs) compõem a interface entre o sistema
Organização operacional e o programa do usuário. O programa inteiro pode ser armazenado
OB no OB1, o qual é ciclicamente chamado pelo sistema operacional (programa linear) ou 

pode ser dividido e armazenado em vários blocos (programa estruturado).

Função Uma função (FC) contém uma parte funcional do programa. É possível
FC, SFC programar funções de modo que sejam parametrizáveis. Com isso as funções são 

ideais para serem reutilizadas no programa, e para realizarem tarefas complexas como 
cálculos.
Funções de sistema (SFC) são funções parametrizáveis integradas ao sistema 
operacional da CPU. Seu número e funcionalidade são fixos. Maiores informações 
podem ser encontradas na Ajuda Online.

Bloco de Função Basicamente os blocos de função oferecem as mesmas possibilidades que as
FB, SFB funções. Adicionalmente, os blocos de função possuem sua própria área de memória, 

sob a forma de blocos de dados instance (instance data blocks). Com isso as funções 
são ideais para serem reutilizadas no programa, e para realizarem tarefas complexas 
como controle em malha fechada.
Blocos de Funções de Sistema (SFB) são funções parametrizáveis integradas ao 
sistema operacional da CPU. Seu número e funcionalidade são fixos. Maiores 
informações podem ser encontradas na Ajuda Online.

Blocos de Dados Blocos de Dados (DB) são áreas de dados do programa do usuário nas quais os dados 
relativos ao mesmo são gerenciados de maneira estruturada.

Operações A utilização de todas as operações é possível em todos os blocos (FB, FC e OB). 
Permitidas



Programa Linear O programa completo se encontra em um bloco contínuo. 
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Este modelo assemelha-se ao de um controle feito com relês, e que foi 
substituído por um controlador lógico programável. A CPU processa as 
instruções individuais uma após a outra.

Programa O programa está dividido em blocos, dentro dos quais cada bloco contém   
Particionado somente um programa destinado a solucionar uma tarefa parcial. Internamente 

também é possível particionar o bloco através de segmentos (networks). É 
possível gerar padrões para networks do mesmo tipo.

O bloco de organização OB 1 contém instruções para a chamada de outros 
blocos numa seqüência definida. 

Programa Um programa estruturado contém blocos com parâmetros, ou parametrizáveis. 
Estruturado Estes blocos são criados de forma a serem utilizados universalmente. 

Ao realizar a chamada de um bloco parametrizável são fornecidos parâmetros  
(os endereços exatos de entradas e saídas, e assim como de valores de 
parâmetros). 

Exemplo:

• Um bloco “Bomba” possui instruções para o controle de uma bomba.

• Os blocos de programa responsáveis pelo controle de bombas especiais 
chamam o bloco “Bomba” e transferem informações à respeito de qual 
bomba será controlada e com quais parâmetros.

• Quando o bloco “Bomba” completa a execução de suas instruções o 
programa retorna para o bloco onde foi feita a chamada (por ex. OB 1), e o 
processamento das instruções continua.
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Introdução A CPU checa o status das entradas e saídas em todo ciclo. Existem áreas de 
memória específicas nas quais os dados binários dos módulos são 
armazenados: a PII e a PIQ. O programa acessa esses registradores durante o 
processamento. 

PII A tabela-imagem de processo de entrada se encontra na área de memória da 
CPU. O estado dos sinais de entrada é armazenado nela. 

PIQ A tabela-imagem de processo de saída contém os valores das saídas que 
resultam da execução do programa. Eles são enviados às saídas (Q) ao final do 
ciclo. 

Programa Ao checar as entradas no programa do usuário, por exemplo, A I 2.0, o último 
estado da PII é avaliado. Isso garante que o mesmo estado lógico do sinal 
valerá se houver múltiplas referências durante a execução do ciclo atual.
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Inicialização A CPU executa um restart completo (com o OB100) ao ser ligada, ou quando 
chaveada de STOP --> RUN. Durante um restart completo, o sistema 
operacional apaga os bits de memória não-retentivos, temporizadores e 
contadores, apaga a pilha de interrupção (interrupt stack ou ISTACK) e a pilha 
de blocos (block stack ou BSTACK), faz um reset em todas as interrupções de 
hardware armazenadas e interrupções de diagnóstico e inicia o monitoramento 
do tempo de ciclo de scan.

Ciclo de Scan A operação cíclica da CPU consiste em três tarefas principais, de acordo com o 
diagrama acima:

• A CPU checa o estado dos sinais de entrada e atualiza a tabela-imagem de 
processo de entrada;

• Executa o programa do usuário com suas instruções respectivas; e

• Escreve os valores provenientes da tabela-imagem de processo de saída 
nos módulos de saída. 



Inserindo um Bloco Selecione a seqüência de menus  Insert -> S7 Block para visualizar uma lista 
com os diferentes tipos de blocos:

SITRAIN Training for
Automation and Drives

Programação Básica em STEP 7
Arquitetura dos Blocos / O Editor de BlocosPágina 5-6

com os diferentes tipos de blocos:

• Os blocos de organização (OB) são chamados pelo sistema operacional. 
Eles compõem a interface entre o sistema operacional e o programa do 
usuário.

• Funções (FC) e blocos de funções (FB) contêm o programa atual do 
usuário. Eles permitem que um programa complexo seja dividido em 
unidades pequenas e fáceis de compreender. 

• Os blocos de dados (DB) contêm os dados do usuário.

Após escolhido o tipo de bloco a caixa de diálogo "Properties" se abre para que 
se possa especificar o número do bloco e a linguagem de programação a ser 
utilizada (LAD, STL ou FBD).
Existem outras opções a serem selecionadas, dependendo do tipo de bloco, 
mas serão enumeradas mais tarde. 

Efetuando as escolhas e confirmando com o botão "OK” o novo bloco é inserido 
no programa atual. 



Iniciando o Editor Inicia-se o Editor LAD/STL/FBD selecionando Start -> Simatic -> STEP7 -> 
LAD,STL,FBD - Programming S7 Blocks. 
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LAD,STL,FBD - Programming S7 Blocks. 

A forma mais rápida e recomendada para iniciar o Editor é: 

1. Selecione o objeto "Blocks" na janela do projeto do SIMATIC Manager.

2. Faça um duplo-clique num bloco qualquer para abrir o Editor.

Elementos do Utilizando as linguagens de programação LAD e FBD pode-se inserir elementos 
Programa gráficos simples de programação diretamente a partir da barra de ferramentas. 

Clique no ícone "Program Elements" para abrir a outra janela contendo mais 
elementos de programa. O conteúdo desta janela depende da linguagem de 
programação selecionada (LAD/FBD/STL). 



Componentes Iniciando o Editor LAD/STL/FBD aparecem automaticamente duas janelas: a 
tabela de declarações e a seção de programa. O usuário pode abrir também 
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tabela de declarações e a seção de programa. O usuário pode abrir também 
uma terceira janela, designada "Program Elements".

Tabela de A tabela de declarações pertence ao bloco. É utilizada para declarar variáveis e

Declarações parâmetros para o bloco. 

A tabela de declarações é discutida em detalhes no capítulo ”Funções e blocos 
de Funções". 

Seção de A seção de programa contém o próprio programa, dividido em segmentos

Programa separados (networks) se necessário. 

Durante a edição as entradas são analisadas para que a sintaxe fique correta. 

Elementos de O conteúdo da janela "Program Elements" depende da linguagem de  
Programa programação selecionada. 

Para que os elementos desta lista possam ser inseridos no programa selecione 
o elemento com o cursor e faça depois um duplo-clique no mesmo.
Pode-se também inserir estes mesmos elementos arrastando-os com o mouse.



Introdução Existem várias linguagens de programação em STEP 7, que podem ser usadas 
dependendo da preferência e conhecimento. Aderindo a regras específicas, o 
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dependendo da preferência e conhecimento. Aderindo a regras específicas, o 
programa pode ser criado em Lista de Instruções e depois convertido para 
outras linguagens de programação.  

LAD A representação em Diagrama de Contatos é muito similar a um diagrama de 
circuito elétrico. São utilizados símbolos como contatos e bobinas. Essa 
linguagem de programação é preferida por aqueles que “cresceram” com os 
contatores. 

STL A Lista de Instruções é composta por instruções STEP 7. Pode-se programar 
de uma forma praticamente livre em STL (algumas vezes ao ponto de já não 
conseguir seguir mais o programa). Esta linguagem de programação é preferida 
pelos programadores que já estão familiarizados com outras linguagens de 
programação. 

FBD O Diagrama de Blocos de Funções utiliza “caixas” para as funções individuais. 
O caractere na caixa indica a função (por ex. & --> Operação Lógica AND). 
Essa linguagem de programação tem a vantagem de que até um “não 
programador” como por exemplo um engenheiro de processo pode trabalhar 
com ela. O Diagrama de Blocos de Funções está disponível desde a Versão 3.0 
do Software STEP7. 



Menu View Escolhendo-se o menu View é possível alternar entre as diferentes linguagens 
de programação STEP 7: 
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de programação STEP 7: 

• LAD (Diagrama de Contatos);

• FBD (Diagrama de Blocos de Funções);

• STL (Lista de Instruções). 

LAD/FBD => STL Pode-se converter as seções do programa que foram escritas em programação 
gráfica na representação STL. Deve-se, porém, estar consciente de que o 
resultado destas conversões nem sempre é a solução mais eficiente em Lista 
de Instruções. 

STL => LAD/FBD Nem sempre é possível converter seções do programa escritas em STL para 
LAD e FBD. As seções do programa que não podem ser convertidas 
permanecem em STL. 

Não são perdidas quaisquer seções do programa durante a conversão.



Elementos Os elementos utilizados mais freqüentemente em LAD e FBD aparecem como 
ícones na barra de ferramentas. Através de um clique com o mouse é possível 
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ícones na barra de ferramentas. Através de um clique com o mouse é possível 
inseri-los no programa na posição pretendida.

Barra de ferramentas em LAD:

Barra de ferramentas em FBD:

Pode-se inserir outros elementos no programa a partir da lista existente na 
janela "Program Elements":
• em qualquer posição arrastando com o mouse 
• na posição selecionada com o um duplo-clique no elemento da lista 

pretendido.

Networks Escolhendo-se o ícone "New Network“           na barra de ferramentas é 
acrescentado um novo network após ao que estiver selecionado. 

Nota Para inserir um segmento antes do segmento NW1 deve-se selecionar o nome 
do bloco ("FC1: Plant" no exemplo acima) antes de fazer um clique no ícone 
"New Network". 

Caixa Vazia Pode-se em LAD ou FBD utilizar uma caixa vazia para inserir elementos de 
programa mais rapidamente. Os elementos podem ser inseridos diretamente, 
sem selecioná-los na lista.

Após selecionar a posição no segmento onde se deseja inserir um elemento, 
clique no ícone “Empty Box“            na barra de ferramentas.

Dando entrada nas primeiras letras do nome de um elemento, a lista dos 
elementos que começam por estas letras aparecem para então fazer a seleção. 



Instruções O usuário precisa conhecer as instruções para escrever um programa em STL. 
Podem-se obter informações sobre sintaxe e funcionalidade a partir da ajuda 
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Podem-se obter informações sobre sintaxe e funcionalidade a partir da ajuda 
on-line: Help -> Help on STL.

Estão disponíveis as seguintes informações:

"Statement List Instructions“: uma descrição de todas as instruções 
que existem na linguagem de programação

"Working with Statement List“: uma descrição sobre

Panorâmica da Lista de Instruções e Sintaxe Geral
Entrada e Visualização de Dados Constantes
Tipos de Blocos

Contatos e Estados dos Sinais 

Elementos de Utilizando o editor STL a janela "Program Elements" contém apenas a lista dos 

Programa blocos existentes que podem ser chamados a partir do bloco que está sendo 
programado.

Networks Os networks podem ser inseridos da mesma maneira que no editor LAD/FBD  
(ver página anterior). 

Fazendo Alterações Pode-se utilizar a tecla "Insert" para trocar entre o modo "Overwrite" e "Insert". 
O modo selecionado aparece na barra de status. 



Salvando um Bloco Terminando a edição de um bloco é possível salvá-lo no disco rígido do 
programador: 
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programador: 

• através da seleção de menus File -> Save  ou 

• clicando no ícone do disco            na barra de ferramentas.



Execução Para que um novo bloco criado seja parte integrante da execução cíclica do 
Cíclica programa da CPU ele deve ser chamado no OB1. 
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Cíclica programa da CPU ele deve ser chamado no OB1. 
A forma mais fácil de inserir a chamada de um bloco graficamente em LAD e 
FBD é através da lista de instruções já conhecida (ver figura acima). Na 
linguagem de programação STL a instrução para a chamada de um bloco é a 
instrução CALL.



Transferindo Pode-se transferir blocos para o CPU com o SIMATIC Manager: 
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• clicando no ícone           ou

• selecionando a opção de menu PLC -> Download.

Antes de fazer isto deve-se selecionar os blocos a se transferir:

• Todos os Blocos: Selecione o objeto "Blocks“ na parte esquerda da 
janela do projeto. 

• Alguns Blocos: Pressionando a tecla CTRL e selecionando os blocos. 

• Um Bloco: Selecionando o Bloco.



Requisitos Antes de ativar o modo de monitoração deve-se abrir o bloco a ser testado tanto 
em offline ou online através do Editor LAD/STL/FBD.
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em offline ou online através do Editor LAD/STL/FBD.

Nota: Para testar um bloco no modo offline ele deve ser primeiro transferido 
para o PLC. 

Ativação / Existem duas maneiras de ativar / desativar a função de teste “Monitor":
Desativação

• clique no ícone 

• selecione a opção de menu  Debug -> Monitor.

Visualização O status do programa é mostrado de maneira diferente dependendo da 
linguagem de programação selecionada (LAD/STL/FBD).

Quando a função de teste é ativada não é possível mudar a linguagem de 
programação do bloco que está sendo analisado (LAD/FBD/STL). 

Nota Mais informações sobre teste de programas são vistas no capítulo “Procura de 
Defeitos”.



Fazendo Correções Podem-se fazer correções em blocos que tenham sido abertos tanto em online
nos Blocos como em offline; porém, nunca no modo de teste.
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nos Blocos como em offline; porém, nunca no modo de teste.

• Normalmente o bloco modificado é transferido para o PLC, testado, são 
feitas algumas correções se necessário, e finalmente gravado no disco 
rígido quando completamente testado. 

• No caso de não testar-se o programa de imediato, pode-se apenas salvar as 
alterações no disco rígido. A versão antiga do bloco é apagada neste caso. 

• Realizando correções num número variado de blocos e não querendo 
apagar a versão original pode-se primeiro transferir os blocos alterados 
para a CPU, sem gravá-los no disco rígido do PG. Pode-se então salvá-los 
depois, quando todo o programa tiver sido testado com êxito. 

Insert / Overwrite O modo insert (inserir) está selecionado por default para LAD ou FBD. Ao 
pressionar a tecla “Insert (Ins)” ativa-se o modo overwrite (sobrescrever). Sendo 
assim pode-se, por exemplo, modificar um tipo de temporizador para um outro 
tipo (por ex., ON delay – retardo na energização por OFF delay - atraso na 
desenergização), sem ter que alterar as entradas e saídas dos mesmos. 



Objetivo Utilizando as chaves não-retentivas do simulador I 0.2 e I 0.3, habilite o jog do 
motor do transportador para a direita (Q 5.5) e para a esquerda (Q 5.6), 
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motor do transportador para a direita (Q 5.5) e para a esquerda (Q 5.6), 
respectivamente. Se ambas chaves forem pressionadas simultaneamente o motor 
do transportador não pode se movimentar. 

O Que Fazer 1. No SIMATIC Manager, insira um bloco novo FC16.
Selecione a pasta Blocks -> Insert -> S7 Block -> Function -> na caixa de 
diálogo Properties escolha FBD como linguagem de programação

2. Inicie o Editor LAD/STL/FBD clicando duas vezes sobre o FC 16

3. Abra a lista de instruções clicando em

4. Edite o Network 1 do FC16 (veja a figura)
usando o mouse, copie o símbolo lógico da lista de instruções para o ponto 
correto na seção de códigos do bloco -> preencha os endereços da operação 
lógica -> para negar um endereço selecione

5. Corrija os símbolos para as entradas I 0.2 e I 0.3
clique no endereço com o botão direito do mouse -> Edit Symbols...

5. Adicione um novo network usando e programe o Network 2 
analogamente

6. Salve o bloco offline usando 

7. Transfira o bloco para a CPU usando

Trocando a • Observe também o bloco nas linguagens LAD/STL/FBD.
Linguagem de Editor LAD/STL/FBD -> View -> LAD/STL/FBD
Programação



Objetivo No OB 1, programe a chamada do FC 16 para que seja ciclicamente 
executada.
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executada.

What To Do 1. Abra o bloco OB 1 com o Editor LAD/STL/FBD 

2. No menu "View“, selecione a linguagem FBD

3. Abra a lista de instruções usando

4. Na lista, abra a pasta "FC Blocks" e arraste com o mouse o FC 16 dentro do  
Network 1 do OB 1

5. Salve o bloco offline usando

6. Transfira o bloco para a CPU usando

7. Abra o bloco FC 16 mais uma vez usando o Editor LAD/STL/FBD

8. Teste o FC 16 usando 



Fonte Selecione neste campo a fonte e o tamanho do texto para a programação. 
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Visualização Pode-se visualizar os blocos:

de Blocos Abertos • com endereçamento simbólico ou absoluto; 

• com ou sem informação de símbolos;

• com ou sem comentários de bloco e network; e

• na linguagem em que foram escritos ou numa linguagem pré-selecionada 
(LAD/STL/FBD).

Visualização de Tipos de Blocos...

... Blocos Lógicos Escolhe-se um dos campos  “STL”, “LAD” ou “FBD” para selecionar a 
linguagem para editar um novo bloco. 

Os blocos de função multi-instance serão discutidos no curso de programação 
avançada. 

... Blocos de Dados Pode-se visualizar os blocos de dados das seguintes maneiras:

• visualizando as declarações; ou 

• visualizando os dados.



Campos de Status Ao visualizar o status de um bloco em STL apenas os campos ativados na 
caixa de diálogo serão exibidos. São disponíveis as seguintes opções: 
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caixa de diálogo serão exibidos. São disponíveis as seguintes opções: 

• Status Bit O bit de estado é mostrado. 

• RLO O resultado lógico da operação (RLO) é mostrado.

• Default Status A palavra de um temporizador, a palavra de um contador 
ou o conteúdo do acumulador 1 (ACCU 1) são exibidos -
dependendo da operação utilizada.

• Address Os registradores de endereço são utilizados com 
Registers *) endereçamento indireto. 

• Accumulator 2 O conteúdo do acumulador 2 (ACCU 2) é exibido.

• DB Registers *) O conteúdo do registro dos blocos de dados relevantes 
é exibido. 

• Indirect *) Esta visualização é possível apenas com o endereçamento  
indireto de memória. 

• Status Word A palavra de estado da CPU é exibida. 

• Default O botão “Default” seleciona o conjunto standard de sistema 
para o campo de exibição Status Field.
Isso corresponde ao bit de estado, o RLO e o standard 
status. 

• Activate New Breakpoints Immediately
Essa opção só é relevante para a função de teste 
“Breakpoint”.

Nota* ) Os tópicos “Endereçamento Indireto” , “Registradores de DB“ e a estrutura da 
palavra de estado da CPU são discutidos no curso de programação avançada.



Layout Aqui seleciona-se o formato da impressão:
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• DIN A4 Portrait

• DIN A4 Landscape

• maximum size.

Largura do Campo Pode-se selecionar o limite para o número máximo de caracteres no nome de
de Endereços um endereço entre os números 10 e 24. Isso altera a largura dos elementos de 

programa em LAD e FBD. Com a representação simbólica uma quebra de linha 
aparece, de acordo com a largura dada no campo largura de endereços.

Representação Os elementos do programa podem ser visualizados em duas maneiras:
dos Elementos • 2-dimensões; ou

• 3-dimensões.

Linha / Cor Pode-se utilizar esta caixa para definir como ser exibido 

• Elemento Selecionado (cor)

• Contatos (linha)

• Status Preenchido (cor e linha)

• Status Não-preenchido (cor e linha)

Type Check Quando se edita um bloco, o tipo de endereço utilizado em instruções de bit 
lógico é sempre verificado.

No entanto pode-se desativar a verificação (no campo “Type Check”) para 
endereços usados em comparações, operações matemáticas etc. (este 
procedimento deve apenas ser utilizado por programadores experientes). 



Gerar Dados Ao modificar e salvar blocos, os dados referentes a esse bloco serão logo 
de Referência atualizados se o campo “Generate Reference Data" da seção “Create Block" 

SITRAIN Training for
Automation and Drives

Programação Básica em STEP 7
Arquitetura dos Blocos / O Editor de BlocosPágina 5-23

de Referência atualizados se o campo “Generate Reference Data" da seção “Create Block" 
estiver selecionado. 

Se essa opção não estiver selecionada os dados referentes ao bloco não serão 
logo atualizados. Porém, da próxima vez em que se abrir a janela “Displaying 
S7 Reference Data", deve-se optar por atualizar os dados ou gerá-los 
novamente. 

Nota: O tópico "Reference Data" é discutido em detalhes no capítulo “Procura 
de Defeitos".

Incluir Atributos A opção “Consider System Attribute S7_server" só é relevante se for utilizada
de Sistema... em conjunto com o sistema de controle de processo (PCS7) e não será tratada 

nesse curso. 

Armazenar Dados A opção "Store Process Diagnostics Data" só é relevante utilizando o pacote 
de Diagnóstico do opcional de software "PDIAG“, e não será tratada nesse curso.           
Processo



Arquivos Fonte É possível editar um programa ou partes de um programa no formato de um 
arquivo fonte STL e depois compilá-lo para um bloco. Apenas um arquivo fonte 
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arquivo fonte STL e depois compilá-lo para um bloco. Apenas um arquivo fonte 
pode conter também o código e ser compilado em vários blocos.  

Criar um programa usando um arquivo fonte tem as seguintes vantagens:

• É possível criar e editar o arquivo fonte em qualquer editor ASCII, importar e 
compilar o mesmo em blocos individuais. A compilação gera blocos 
individuais e armazena-os no programa S7 do usuário. 

• É possível programar vários blocos em um arquivo fonte. 

• É possível salvar um arquivo fonte mesmo com erros de sintaxe. Isso não é 
possível na edição do editor LAD/FBD/STL, devido sua supervisão de 
sintaxe. O único problema, portanto, é que os erros de sintaxe serão 
descobertos somente no momento da compilação do bloco. 

O arquivo fonte é criado na sintaxe da linguagem de programação STL (lista de 
instruções). A estrutura do arquivo fonte em blocos, declarações de variáveis ou 
networks se dá através de palavras-chave.  



Nota Nesta seção seleciona-se a estrutura da lista de seleção de símbolos.                            
Pode-se ativar e desativar o aparecimento desta lista na edição através da 
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Pode-se ativar e desativar o aparecimento desta lista na edição através da 
seqüência de menus View -> Display ->Symbol Selection no Editor de 
Programa.

Se o campo da seleção de símbolo estiver ativado, a lista com os símbolos 
atuais da tabela de símbolos aparecerá ao introduzir variáveis em LAD e FBD. 
Na lista que aparece, o símbolo assinalado é aquele que melhor se aplica à 
seqüência de caracteres digitados na posição do cursor. O símbolo pode ser 
aceito com a tecla Enter.


